
 

Microsoft Dynamics® GP
Taxes On Returns



Copyright Copyright © 2010 Microsoft. All rights reserved.

Limitation of liability This document is provided “as-is”. Information and views expressed in this document, including 
URL and other Internet Web site references, may change without notice. You bear the risk of using 
it.

Some examples depicted herein are provided for illustration only and are fictitious. No real 
association or connection is intended or should be inferred.

Intellectual property This document does not provide you with any legal rights to any intellectual property in any 
Microsoft product.

You may copy and use this document for your internal, reference purposes.

Trademarks Microsoft and Microsoft Dynamics are trademarks of the Microsoft group of companies. FairCom 
and c-tree Plus are trademarks of FairCom Corporation and are registered in the United States 
and other countries.

All other trademarks are property of their respective owners.

Warranty disclaimer Microsoft Corporation disclaims any warranty regarding the sample code contained in this 
documentation, including the warranties of merchantability and fitness for a particular purpose.

License agreement Use of this product is covered by a license agreement provided with the software product. If you 
have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 
800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date May 2010



T A X E S O N R E T U R N S i

Contents
Introduction ............................................................................................................................................... 1

What’s in this manual...................................................................................................................................1

Symbols and conventions ............................................................................................................................2

Resources available from the Help menu..................................................................................................2

Send us your documentation comments ...................................................................................................4

Chapter 1: Setup ................................................................................................................................... 5
Understanding taxes on returns .................................................................................................................5

Activating Taxes On Returns.......................................................................................................................5

Deleting the tax detail IDs ...........................................................................................................................6

Chapter 2: Transactions.................................................................................................................. 7
Calculating taxes on returns in Receivables Management .....................................................................7

Calculating taxes when a return is fully applied to a single invoice.....................................................7

Calculating taxes when a return is fully applied to multiple invoices .................................................8

Calculating taxes when a return is partially applied...............................................................................9

Calculating taxes on returns for saved returns.......................................................................................10

Calculating taxes in Sales Order Processing ........................................................................................... 11

Viewing taxes on posted returns .............................................................................................................. 11

Index .............................................................................................................................................................. 13



ii T A X E S O N R E T U R N S



T A X E S O N R E T U R N S 1

Introduction
Taxes On Returns integrates with the Receivables Management and the Sales Order 
Processing modules. It allows you to choose how to calculate taxes when generating 
a return. You can now choose to calculate the taxes based on the tax details of the 
original invoice to which you are applying the return. You can apply returns either 
partially, fully, or for multiple invoices in the Receivables Management. In the Sales 
Order Processing module, you can return an invoice either partially or fully per line 
item or for multiple line items.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use Taxes 
On Returns, and how it integrates with the Microsoft Dynamics GP system.

To make best use of Taxes On Returns, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

The manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to activate the Taxes On Returns feature with 
the Receivables Management and the Sales Order Processing modules.

• Chapter 2, “Transactions,” explains the procedure to generate returns based on 
the taxes of the invoice that the return is applied to.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. To change the 
way required fields are highlighted, choose Tools >> Setup >> User Preferences >> 
Display, and specify a different color and type style.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Taxes On Returns allows you to calculate taxes for a return based on the tax details 
of the posted sales invoice/s that you are applying the return to. Use this 
information to understand how you can use Taxes On Returns while generating 
returns for your company.

This information is divided into the following sections:

• Understanding taxes on returns
• Activating Taxes On Returns
• Deleting the tax detail IDs

Understanding taxes on returns

In some countries/regions, it is necessary that the taxes calculated on return 
documents match the taxes on the posted invoice that the return is applied to. 
Normally, in Microsoft Dynamics GP, taxes are applied to a return based on the tax 
schedule associated with the return. This may be different from the taxes used on 
the original invoice. In this case, you must manually edit every return to ensure that 
the correct taxes are applied.

Taxes On Returns allows you to choose what taxes will be applied to a sales return 
before posting it. Choosing to base taxes on the original invoice automatically 
recalculates the taxes based on the invoices that a return is applied to.

You can use Taxes On Returns in Receivables Management and Sales Order 
Processing when you apply a return to an invoice before posting the return. While 
selecting the invoices to which to apply the return, a message appears asking you to 
choose how taxes will be applied to the return. Refer to Calculating taxes on returns in 
Receivables Management on page 7 and Calculating taxes in Sales Order Processing on 
page 11 for more information.

You cannot use Taxes On Returns functionality for returns that are created directly, or 
saved in the Sales Transaction Entry window.

Activating Taxes On Returns

Use the Taxes On Returns Setup window to activate the Taxes On Returns feature to 
base taxes on the original invoice. You can enable this feature for the Sales Order 
Processing and the Receivables Management modules.
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To activate Taxes On Returns:
1. Open the Taxes On Returns Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Sales >> Taxes On Returns 
Setup)

2. Mark the Activate Taxes On Returns option to activate the feature. This option 
will be marked and unavailable if you select to enable the product for the Sales 
Order Processing or the Receivables Management modules.

3. Mark the Enable in Sales Order Processing option to activate Taxes On Returns 
for the Sales Order Processing module. This option becomes available only if 
you mark the Activate Taxes On Returns option.

You can either choose to base taxes on the original invoice automatically, or 
display a message when selecting invoices to which to apply the return.

4. Mark the Enable in Receivables Management option to activate the Taxes On 
Returns feature for the Receivables Management module. This option becomes 
available only if you mark the Activate Taxes On Returns option.

You can either choose to base taxes on the original invoice automatically, or 
display a message when selecting invoices to which to apply the return.

5. Choose OK to save the information you have set up.

6. Choose Cancel to cancel the process and close the window.

Deleting the tax detail IDs

Once you activate Taxes On Returns, you cannot delete a tax detail ID that is used in 
any posted invoices. If you delete a tax detail ID before activating this feature, you 
cannot use the Taxes On Returns feature to apply a return to an invoice that uses the 
deleted tax detail.
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Chapter 2: Transactions
Use this information to understand how the Taxes On Returns feature works in 
Receivables Management and in Sales Order Processing. You must have enabled the 
Taxes On Returns feature for these modules in the Taxes On Returns Setup window. 
Refer to Activating Taxes On Returns on page 5 for more information.

This information is divided into the following sections:

• Calculating taxes on returns in Receivables Management
• Calculating taxes when a return is fully applied to a single invoice
• Calculating taxes when a return is fully applied to multiple invoices
• Calculating taxes when a return is partially applied
• Calculating taxes on returns for saved returns
• Calculating taxes in Sales Order Processing
• Viewing taxes on posted returns

Calculating taxes on returns in Receivables 
Management

You can choose to calculate taxes based on the original invoice/s to returns that are 
created in the Receivables Transaction Entry window (Transactions >> Sales >> 
Transaction Entry). When you create a return in Receivables Management and 
apply invoices to the return before posting the return, you can calculate taxes based 
on the tax details of the invoices that you apply. The Sales, Tax, and the Total fields 
in the Receivables Transaction Entry window are recalculated based on the tax 
information from the applied invoice/s. If you are using this feature for a return, 
you cannot edit the amount fields once you have selected invoices for which to 
apply the return. You can also not modify the values in the Tax Entry window. To do 
this, you must first unapply all the invoices that you have applied the return to.

Refer to Calculating taxes when a return is fully applied to a single invoice on page 7, 
Calculating taxes when a return is fully applied to multiple invoices on page 8, and 
Calculating taxes when a return is partially applied on page 9 for more information on 
how taxes are calculated based on the original invoice in Receivables Management.

Calculating taxes when a return is fully applied to a 
single invoice

You can fully apply a return to a single invoice. If you have chosen to use the Taxes 
On Returns feature, taxes are calculated based on the tax information of the selected 
invoice.

Example:

Post an invoice with the following details:

Invoice1

Sales 4000.00

Tax1 - 5% 200.00

Tax2 - 6% 240.00

Total amount on the 
invoice

4000.00 + 200.00 + 240.00 = 4440.00
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Create a return and choose Apply to apply it to the posted invoice using Taxes On 
Returns.You must enter the total invoice amount including taxes in the Sales field in 
order to fully apply the return to an invoice.

The tax schedule for the return contains Tax1 = 5% and Tax3 = 11%.

The return is now fully applied. The 16% tax that was previously assigned to the 
return is deleted and the tax information from the invoice is assigned to the return.

Calculating taxes when a return is fully applied to 
multiple invoices

You can fully apply a return to multiple invoices. If you have chosen to use the 
Taxes On Returns feature. Taxes are calculated based on the tax information of the 
selected invoices.

Example:

Post two invoices with the following details:

Create a return and choose Apply to apply the return against the posted invoices. 
Apply the return completely between the two posted invoices using Taxes On 
Returns. The tax schedule for the return contains Tax1 = 5% and Tax3 = 11%.

Return1 Values before 
applying

Values after 
applying to 
Invoice1

Sales 4440.00 4000.00

Tax1 222.00 200.00

Tax3 (per return tax 
schedule)

488.00

Tax2 (per original 
invoice tax schedule)

240.00

Total 5150.00 4440.00

Invoice1 Invoice2

Sales 4000.00 4000.00

Tax1 - 5% 200.00

Tax2 - 10% 400.00

Total 4200.00 4400.00

Return1 Values before 
applying

Values after 
applying to 
Invoice1 & Invoice2

Sales 8600.00 8000.00

Tax1 430.00 200.00

Tax2 400.00

Tax3 946.00

Total 9976.00 8600.00
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Calculating taxes when a return is partially applied

You can partially apply a return to one or more invoices. If you have chosen to use 
the Taxes On Returns feature, taxes for the applied amount are calculated based on 
the tax information of the selected invoice/s. The taxes for the unapplied amount 
are calculated based on the tax schedule selected for the return.

Example:

Post an invoice with the following details:

Create a return and choose Apply. Apply the return partially to the posted invoice 
using Taxes On Returns. The tax schedule for the return contains Tax1 = 5% and 
Tax3 = 11%. Apply an amount 2440 to the invoice. 

Invoice1

Sales 4000.00

Tax1 - 5% 200.00

Tax2 - 6% 240.00

Total 4440.00

Return1 Values before 
applying

Values after 
applying to 
Invoice1

Sales 4440.00 4198.20

Tax1 222.00 209.91

Tax2 (per 
original 
invoice tax 
schedule)

131.89

Tax3 (per 
return tax 
schedule)

488.40 220.00

Total 5150.40 4760.00



C H A P T E R  2    T R A N S A C T I O N S  

10 T A X E S O N R E T U R N S

Calculating taxes on returns for saved returns

You can use the Taxes On Returns functionality for returns that you saved in 
Receivables Management before installing this feature. You cannot use this 
functionality for returns saved in Sales Order Processing.

If you post a saved return without modifying it, or select additional invoices to 
apply, taxes are calculated based on the taxes applicable when you saved the return.

To calculate taxes on returns for saved returns:
1. Open the Receivables Transaction Entry window.

(Transactions >> Sales >> Transaction Entry)

2. Select the return ID to apply taxes on returns.

3. Choose Apply to open the Apply Sales Documents window.

• If you have not applied any invoices to the saved return, select the invoices 
to apply. Based on your setup, taxes are calculated automatically based on 
the original invoice, or a message is displayed asking you to choose how to 
base your taxes. Refer to Activating Taxes On Returns on page 5 for more 
information. 

• If you have applied any invoices to the saved return, you must unapply all 
the invoices in the Apply Sales Documents window and close the window. 
Choose the Apply button again to select the invoice/s to apply the return. 
Based on your setup, taxes are calculated automatically based on the 
original invoice, or a message is displayed asking you to choose how to 
base your taxes. Refer to Activating Taxes On Returns on page 5 for more 
information.
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Calculating taxes in Sales Order Processing

You can calculate taxes based on the tax information of a posted invoice for returns 
created using the Create Returns window (Transactions >> Sales >> Sales 
Transaction Entry >> Additional >> Create Return). 

To use this window, you must have installed and registered Returns Management. 
Refer to Microsoft Dynamics GP Field Service – Returns Management 
documentation for information on setting up and using Returns Management. 

You cannot use the Taxes On Returns functionality for returns created directly in the Sales 
Transaction Entry window.

When you use Returns Management, you can create a return for specific line items 
or for all the items of a posted invoice. If you choose to use the Taxes On Returns 
feature, taxes for each item are calculated based on the item’s tax information in the 
posted invoice. The posted invoice may also have some taxes that are based on the 
document total and not on the line items, for example, taxes on freight and 
miscellaneous charges. When you are using Taxes On Returns, such taxes are 
calculated on the return only if you select all the invoice items in the return.

It is recommended that you do not modify the return once it is available in the Sales 
Transaction Entry window. If you do, the taxes may be recalculated and may no 
longer correspond to those on the original invoice.

Viewing taxes on posted returns

You can view the taxes calculated on posted returns in the Receivables Transaction 
Inquiry - Customer window (Inquiry >> Sales >> Transaction by Customer/
Document). Select the return document for which to view the taxes and click the 
Document Number link to open the Receivables/Sales Transaction Inquiry zoom 
window. Refer to the Receivables Management or the Sales Order Processing 
documentation for more information.
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